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4 Projekt texturel

4+ Forml, OnResize, OnTimer

+ Embedded Resource = Eingebaute Daten
4 Weitere Aufgaben

Projekt texturel

Diese Ubungsaufgabe ist eine kurze, iibersichtliche Fassung eines Direct3D-Tutorials von Microsoft:
Tutorial4. Sie finden es unter C:\DXSDK\Samples\Managed\Direct3D\Tutorials\Tutorialb5.

Main Menu nach dem Start von VS 2005: File -> New Project... -> Templates: Windows
Application

Name: texturel -> Location: C:\temp -> Create directory for solution: ausschalten ->
OK

Léschen Sie die Files Program.cs und Forml.Designer .cs und den Inhalt von Forml.cs, wie es in den
Kapiteln 2DCisC1 bis 2DCisC4 beschrieben wurde.

Falls das Solution Explorer - Fenster nicht schon offen ist, 6ffnen Sie es lUiber das Hauptmeni: View ->
Solution Explorer.

Im Solution Explorer - Fenster klicken Sie auf das Pluszeichen vor texturel. Es 6ffnet sich ein Baum.
Ein Ast heilRt "References". Klicken Sie mit der rechten Maustaste auf References und dann mit der linken
Maustaste auf Add Reference. ... Es 6ffnet sich eine Add Reference Dialog Box. Scrollen Sie abwarts, bis
Sie den Component Name: Microsoft._DirectX Version 1.0.2902.0 sehen.

Markieren Sie durch Linksklick diese Referenz und (bei gedriickter der Strg-Taste) die weiter unten stehende
Referenz Microsoft._DirectX.Direct3D Version 1.0.2902.0. Verlassen Sie die Add Reference
Dialog Box mit OK.

Kontrollieren Sie, ob jetzt im Solution Explorer Fenster unter texturel -> References (unter anderen) die
beiden Referenzen Microsoft._DirectX und Microsoft.DirectX._Direct3D stehen.

Form1l, OnResize, OnTimer

Schreiben in das leere Codefenster Forml. cs folgenden Code:

using System;

using System.Drawing;

using System.Windows.Forms;

using Microsoft.DirectX;

using Microsoft.DirectX.Direct3D;

public class Forml : Form

{ static void Main() { Application.Run( new Formi1(Q) ); }
static Device device = null;
static float xAngle, yAngle, zAngle;
static Vector3 xAxis = new Vector3( 1, 0, 0 );
static Vector3 yAxis new Vector3( 0, 1, 0 );
static Vector3 zAxis new Vector3( 0, 0, 1)
VertexBuffer vertexBuffer;
Bitmap bmp null;
Texture texture null;
const Int32 N 100; //N must be an even no. 6, 8, 10, etc
CustomVertex.PositionNormalTextured[] vv = new CustomVertex.PositionNormalTextured[N];
Timer myTimer = new Timer();

public Form1()

{ Menultem miRead new Menultem( "Read", new EventHandler( MenuFileRead ) );
Menultem miExit new Menultem( "Exit", new EventHandler( MenuFileExit ) );
Menultem miFile new Menultem( "File", new Menultem[] { miRead, miExit } );

Menu = new System.Windows.Forms.MainMenu( new Menultem[] { miFile } );
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try { bmp = (Bitmap)lImage.FromFile( ""C:\\DXSDK\\Samples\\Media\\Tiger\\tiger_bmp™ ); }
catch { try { //Delete this inner try-catch clause if you have no Internet connection running.

String s = "http://www.miszalok.de/Images/tiger.bmp*;
System._Net.WebRequest webreq System._Net._WebRequest.Create( s );
System._Net.WebResponse webres = webreq.GetResponse();
System.10.Stream stream = webres.GetResponseStream();
bmp = (Bitmap)lImage.FromStream( stream );
} catch {}; }; // end of inner and outer try-catch clauses
Text = "D3DTexture: Use the File menu to read new textures !'";
//TriangleStrip forming a cylinder
//radius = 1; axis = Z-axis; top = 1; bottom = -1; => height = 2;
//in order to see the vertices, replace the the TriangleStrip by a LineStrip in OnTimer(...)
float arcus_increment = (float)(2.0 * Math.PI / (N-2)); //cylinder angular increment
float tu_increment = (float) (1.0 / (N-2)); //texture horiz. increment
Vector3 v = new Vector3();
for (int 1 = 0; 1 < Nj; i++)
{ float arcus = i * arcus_increment;
v.X = (Ffloat)Math.Cos( arcus );
v.Y = (float)Math.Sin( arcus );
if (%2 ==0) v.Z = 1f;

else v.Z = -1F; //zigzag between top and bottom
vv[i].Position = v; //vertex = (cos,sin,+1) or (cos,sin,-1)
v.Z = 0; //cylinder normals have no Z-component
vv[i]-Normal = v; //normal = (cos,sin,0)

w[i]-Tu = i * tu_increment; //horizontal texture position
if ( 1%2 == 0 ) vv[i].-Tv = 0Of;
else vw[i].-Tv = 1f; //vertical zigzag on texture image
}
myTimer.Tick += new EventHandler( OnTimer );
myTimer.Interval = 1;
ClientSize = new Size( 400, 300 ); //Calls OnResize( ... )

}

protected override void OnResize( System.EventArgs e )
//Whenever the window changes we have to initialize Direct3D from scratch
{ myTimer.Stop();// stop the timer during initialization
try
{ //get information from the operating system about its current graphics properties
PresentParameters presentParams = new PresentParameters();
//we have to set two flags
presentParams._Windowed = true; //no full screen display
presentParams.SwapEffect = SwapEffect.Discard; //no swap buffer
presentParams.EnableAutoDepthStencil true; //with depth buffer
presentParams.AutoDepthStencilFormat = DepthFormat.D16; //16 bit depth
//Create a new D3D-device that serves as canvas.
if ( device !'= null ) device.Dispose(); //free the old canvas if any
device = new Device( 0, DeviceType.Hardware, this,
CreateFlags.SoftwareVertexProcessing, presentParams );
//Create a white material.
Material mtrl = new Material();
mtrl.Diffuse = mtrl.Ambient = Color.White;
device.Material = mtrl;
//Create a single, white, directional, diffuse light source and a gray ambient light.
//Many lights may be active at a time. (Notice: Each one slows down the render process.)
device.Lights[0]-Type = LightType.Directional;
device.Lights[0].Diffuse = System.Drawing.Color.White;
device.Lights[0].Direction = new Vector3( 0, 1, 1 );
device.Lights[0] -Enabled = true; //turn it on
//Finally, turn on some ambient light that scatters and lights the object evenly
device._RenderState.Ambient = System.Drawing.Color.FromArgb( 0x202020 );
//setup texture
if ( texture != null ) texture.Dispose();
if ( bmp = null) texture = Texture.FromBitmap( device, bmp, 0, Pool_Managed );
device.SetTexture( 0, texture );
//set up the transformation of world coordinates into camera or view space
device.Transform._View = Matrix.LookAtLH(
new Vector3( OFf, OFf,-4f ), //eye point 4.0 in front of the canvas
new Vector3( Of, Of, Of ), //camera looks at point 0,0,0
new Vector3( Of, 1f, OfF ) ); //worlds up direction is the y-axis
//set up the projection transformation using 4 parameters:
//1.: field of view = 45 degrees; 2.: aspect ratio = heigth / width = 1 = square window;
//3.: near clipping distance = 0; 4.: far clipping distance = 10;
device.Transform.Projection = Matrix.PerspectiveFovLH((float)Math.P1/4, 1f, 1Ff, 10F );



device.RenderState.Cul IMode Cull .None;
device.RenderState.Lighting true;

//set up the property that fills the triangle with colors
device.VertexFormat = CustomVertex.PositionNormalTextured.Format;
//create a new vertex buffer and connect it to the device

if ( vertexBuffer != null ) vertexBuffer.Dispose(); //free the old vertexBuffer if any
vertexBuffer = new VertexBuffer( typeof(CustomVertex.PositionNormalTextured), N,

device, O,

CustomVertex.PositionNormalTextured.Format,

Pool .Default );
//copy the coordinates and colors of "vv" into the vertex buffer
vertexBuffer_SetData( vv, 0, LockFlags.-None );
device.SetStreamSource( 0, vertexBuffer, 0 );
myTimer.Start();//start the timer again

catch (DirectXException) { MessageBox.Show( "Could not initialize Direct3D." )

}
}

protected static void OnTimer( Object myObject, EventArgs myEventArgs )
{ if (device == null) return;
//throw the old image away

device.Clear( ClearFlags.Target | ClearFlags.ZBuffer, Color.CGray, 1f, 0 );

//rotate with 3 angular velocities
xAngle += 0.1F;
yAngle += 0.02f;
zAngle += 0.02F;
device.Transform.World = Matrix.RotationAxis( xAxis, xAngle );
device.Transform_World *= Matrix.RotationAxis( yAxis, yAngle );
device.Transform.World *= Matrix.RotationAxis( zAxis, zAngle );
//draw on the canvas
device.BeginScene();
device.DrawPrimitives( PrimitiveType.TriangleStrip, 0, N-2 );
//Experiment: Replace the TriangleStrip by a LineStrip as follows:
//device._DrawPrimitives( PrimitiveType.LineStrip, 0, N-2 );
device.EndScene();
device._Present(); //show the canvas

}

void MenuFileRead( object obj, EventArgs ea )

{ try
{ OpenFileDialog dlg = new OpenFileDialog();

dlg.Filter = "images |*.bmp;*.gif;*.jpeg;*.jpg;*.png;*.tif;*_tiff;*_bmp|" +

"Windows Bitmap (*.bmp)|*.bmp|" +
"Graphics Interchange Format (*.gif)|*.gif|" +

"Joint Photographic Experts Group (*-jpg)|*-jpg;:*-jpegl” +

"Portable Network Graphics (*.png)|*.png|" +
"Tag Image File Format (*.tif)|*.tif;*_tiff|" +
ALl files (<. *)|*.*";

if ( dlg.-ShowDialog() !'= DialogResult.OK ) return;

bmp = (Bitmap)Image.FromFile( dlg-FileName );

OnResize( null );

}

catch

}

void MenuFileExit( object obj, EventArgs ea )
{ Application.Exit(Q); }

{ MessageBox.Show ( "Cannot read', '"D3DTexture', MessageBoxButtons.OKCancel ); }

}

return;

Klicken Sie Debug -> Start Without Debugging Ctrl F5. Erproben Sie das Programm durch ziehen an

allen Fensterrandern.



Embedded Resource = Eingebaute Daten

Unser Programm braucht beim Starten das Bild ""tiger.bmp' und im Konstruktor public Form1() sucht es
zunéchst auf der Festplatte unter "'C:\\DXSDK\\Samples\\Media\\Tiger\\tiger.bmp" und, wenn dort
nichts zu finden ist, im Internet unter **http://www._miszalok.de/Images/tiger _bmp™.

Problem: Wenn beides nicht funktioniert, startet unser Textur-Programm ohne Textur.

Losung: Bauen Sie ""tiger.bmp" in das Programm fest ein:

1. Wenn es nicht schon offen ist, 6ffnen Sie das Solution Explorer-Fenster und klicken mit der rechten
Maustaste auf den Ast texturel. Im Kontextmeni klicken Sie Add. Im néchsten Kontextmen klicken Sie Add
Existing ltem....Im sich jetzt 6ffnenden File Dialog klicken sie ganz unten am Ende der Files of
type:-Textbox auf das Dreieck und wahlen Image Files (*.bmp, ... ). Dann suchen Sie auf lhrer
Festplatte unter "'C:\\DXSDK\\Samples\\Media\\Tiger\\tiger.bmp" oder sonstwo nach tiger.bmp
und binden es ein. tiger .bmp muss jetzt als Ast von texturel im Solution Explorer-Fenster stehen.
Beim Rechtsklick auf diesen Ast erhalten Sie ein Kontextment. Klicken Sie auf dessen letzte Zeile
Properties. Im Eigenschaftenfenster &ndern Sie die Eigenschaft Bui ld Action von Content auf
Embedded Resource.

2. Ldschen Sie im Konstruktor public Forml() folgenden Block von Zeilen:

try { bmp = (Bitmap)Image.FromFile( "C:\\DXSDK\\Samples\\Media\\Tiger\\tiger._bmp"

catch { try { //Delete this inner try-catch clause if you have no Internet
connection running.

String s = "http://www.miszalok.de/Images/tiger.bmp™;
System_Net.WebRequest webreq = System.Net._.WebRequest.Create( s );
System._Net._WebResponse webres = webreq.GetResponse();

System._10.Stream stream = webres.GetResponseStream();

bmp = (Bitmap)Image.FromStream( stream );

} catch {}; }; // end of inner and outer try-catch clause<

und ersetzen Sie das enstandene Loch durch eine einzige Zeile:
bmp = new Bitmap( typeof( Forml ), "texturel.tiger.bmp"™ ); //read the embedded
resource

Jetzt enthélt das ausfiihrbare texturel . exe einen festen Bestandteil, ndmlich die initiale Textur.
Vorteil: ""tiger.bmp" ist beim Starten immer da, unabhéngig von der Festplattenstruktur und vom Internet.
Nachteil: Das ausfihrbare texturel.exe (bisher 20 KB) schwillt um die Bildgrée (=60 KB) auf 80 KB an.

Weitere Aufgaben

1. Lesen Sie beliebige Bilder zur Laufzeit ein. Eine Bildersammlung finden Sie unter
C:\DXSDK\Samples\Media\.

2. Ersetzen Sie in der 5.-letzte Zeile von protected static void OnTimer( Object myObject,
EventArgs myEventArgs ) den Bezeichner TriangleStrip durch LineStrip.

3. Ersetzen Sie im Konstruktor public Form1() in der Zeile float tu_increment = (float)(1.0 /
(N-2)); die 1.0 durch eine 2.0, dann 3.0 etc.

4. Ersetzen Sie im Konstruktor public Forml() in der Zeile else vv[i].-Tv = 1f; die 1f durch eine 2F,
dann 3F etc.

5. Bremsen Sie die Animation durch hoch setzen von myTimer . Interval = 100; im Konstruktor.

6. Beschleunigen Sie die Animation durch hoch setzen von xAngle, yAngle und/oder zAngle in OnTimer.
7. Drehen Sie die R6hre um nur eine Achse in OnTimer.

8. Geben Sie dem diffusen Licht eine andere Farbe.

9. Geben Sie dem ambienten Licht eine andere Farbe.

10. Andern Sie die Position der Lichtquelle: nur von oben, nur von unten, nur von links etc.

11. Treten Sie mit dem Augenpunkt weiter zurtick von ( Of, Of,-4f ) nach ( OF, Of,-100f ) und naher
heran mit ¢ OF, OF,-2F ).

12. Lesen Sie die Kommentare und versuchen Sie, den Sinn der Befehle zu verstehen.

13. Sie finden Erklarungen und Kommentare zu dieser Ubung unter
http://msdn.microsoft.com/library/default.asp.

Verzweigen Sie in dem Baum auf der linken Seite auf: Win32 and COM Development — Graphics and
Multimedia — DirectX — SDK Documentation — DirectX 9.0 SDK Update (February 2006) Managed — DirectX
SDK — Introducing DirectX 9.0 — Direct3D Graphics — Getting Started with Direct3D — Direct3D Tutorials —
Tutorial 5: Using Texture Maps.




